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ABSTRACT 

 

The aim of this project is to design an Automatic Motion Sensing Barrier Gate Control 

System with Automated Sirens and Signal System using an Arduino nano microcontroller. 

This mainly aims at preventing accidents at some level crossing where many accidents take 

place every day. This automatic railway gate controller makes use of one IR sensor placed 

at the gate placed at a particular distance. The sensor detects the arrival of the train and 

sends the signal to the micro-controller to close the gate, sirens automatically and after the 

train left gate will open automatically. When a train detects an IR sensor then a text will 

send to the gate-man's mobile phone by the use of a GSM module. If some obstacle comes 

in front of the train, then the train will be automatically slow. The usage of this automatic 

railway gate controller using a micro controller will largely reduce accidents at the 

unnamed level crossings and provide immense safety. 
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CHAPTER 1 

INTRODUCTION 

 

1.1 Introduction 

 

A level crossing occurs when a railway line is intersected by a road or path on one level, 

without recourse to a bridge or tunnel. It is a type of at-grade intersection. The term also 

applies when a light rail line with separate right-of-way in reserved track crosses a road 

similarly. Other names include railway crossing, railroad crossing, the road through railroad, 

train crossing, or grade crossing. Early level crossings had a flagman in a nearby booth who 

would, on the approach of a train, wave a red flag or lantern to stop allaric and clear the 

tracks.  

 

Manual or electrical closable gates that barricaded the roadway were later introduced. The 

gates were intended to be a complete barrier against the instruction of any road traffic onto 

the railway. In the early days of the railways, much road traffic was horse-drawn or included 

livestock. It was thus necessary to provide a real barrier. Thus, crossing gates, when closed 

to road traffic, crossed the entire width of the road. When opened to allow road users to 

cross the line, the gates were swung across the width of the railway, preventing pedestrians 

or animals from getting onto the line. With the appearance of motor vehicles, this barrier 

became less effective and the need for a barrier to livestock diminished dramatically.  

 

Many countries, therefore, substituted the gated crossings with weaker but more obvious 

barriers and relied upon road users following the associated warning signals to stop. The 

present work is designed using 8051 microcontrollers to avoid railway accidents happening 

at unattended railway gates if implemented in spirit. We have Automatic Railway Gate 

Control System considered 5 seconds for this paper. Sensors are fixed at 1km on both sides 

of the gate. We call the sensor along the train direction as ‘foreside sensor’ and the other as 

‘after side sensor’. When the foreside receiver gets activated, the gate motor is turned on in 

one direction and the gate is closed and stays closed until the train crosses the gate and 

reaches aft side sensors. When the aft side receiver gets activated motor turns in the opposite 

direction and the gate opens and the motor stops. A buzzer will immediately sound at the 

fore side receiver activation and the gate will close after 5 seconds, so giving time to drivers 
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to clear the gate area to avoid trapping between the gates and stop sound after the train has 

crossed. 

 

1.2 Rail Accident in BD: 

[Rff: Accident where at least 12 people were killed when a bus collided with a train at 

Puranapoil area in Joypurhat town on Saturday, December 19, 2020.]  

Bangladesh on Saturday witnessed a tragic train accident in the Puranapoil area of Joypurhat 

Sadar upazila, where a collision between a train and a bus left at least 12 people dead and 

three others injured. Police say the accident is a result of negligence by the level-crossing 

gateman. According to Bangladesh Railway, human errors are accountable for 72% of rail 

accidents in Bangladesh, with 23% of the accidents being results of mechanical failure. 

Human error includes negligence or mistake by the driver, stationmaster, and guard, reckless 

driving, and mechanical failure due to the malfunctioning of locomotives, defective tracks, 

and the signal system. Unprotected railroad crossings and careless crossing of rail tracks by 

vehicle drivers and pedestrians account for 5% of accidents. 

 

Figure 1.1: Rail Accident in BD of negligence by the level-crossing gate man 
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Train accident graph 

Here is shown the graph of human death in rail collision: 

 

 

 

Figure 1.2: Graph of human death in rail collision. 

1.3 Objectives  

The objectives of this project are 

1. To study Automatic Motion Sensing Barrier Gate Control System with Automated 

Sirens and Signal System. 

2. To implement a railway gate control. 

3. To send an alert to the gateman's phone by the use of the GSM Module. 

4. To alert train driver to stop ahead by automatic signal light. 

5. To test the performance of the system. 

6. To test the siren system. 

7. To test the whole project. 
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1.4 Methodology 

Our used methodology for the project: 

1. Creating an idea for the design and construction of an “Automatic Motion Sensing 

Barrier Gate Control System with Automated Sirens and Signal System”. And 

designing a block diagram & circuit diagram to know which components we need to 

construct it.  

2. Collecting all the components and programming the microcontroller to control our 

desired system. 

3. Setting up all the components in a PCB board & soldering. Then assemble all the blocks 

in a board and finally run the system to check if it actually works or not. 

 

1.5 Structure of the Project 

This Project is organized as follows: 

Chapter 1 Introduction: The first chapter contains the statement of the introduction, our 

background study for the project, the problem statement, the objectives of the study, and the 

project outline. 

Chapter 2 Literature Review: Chapter two contains our introduction and literature review 

part. 

Chapter 3 Hardware and Software Analysis: Chapter three describes the theoretical model. 

Here we mainly discuss the proposed system Hardware and software development of our 

project etc. 

 

Chapter 3 Methodology: Chapter three describes the theoretical model. Here we mainly 

discuss the proposed system architecture in detail with having a block diagram, circuit 

diagram, structural diagram, project working principle, complete project image, etc. 

 

Chapter 4 Result and Discussion: Chapter four deals with the result and discussion and 

discuss our project's advantages and application. 

Chapter 5 Conclusion: Chapter five is all about our project conclusion and future scope. 
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CHAPTER 2 

LITERATURE REVIEW 

 

2.1 Introduction  

In this section topics related to Automatic Motion Sensing Barrier Gate Control System 

with Automated Sirens and Signal System are included. These provide a sampling of 

problems appropriate for the application of Automatic railway gate control, send text, and 

auto braking systems. The references are summarized below.   

2.2 Literature Review 

 
Recently, many automatic railways gate controllers with advanced technology are 

introduced to make level crossing risk-free. Al-Zuhairi et.al concentrated on unmanned level 

crossing which caused frequent accidents [2]. For this, they proposed a Microcontroller 

based Railway Gate and Crossing Control system. In their system, they used an IR sensor 

and Microcontroller. 

 

In their system, IR sensors sense the presence of a train and send the signal to 

Microcontroller. Based on the signal Microcontroller controls the gate of the crossing. The 

main limitation of this system is low accuracy. The performance of the IR sensor is not 

adequate in open places and in light. Subrata Biswas et.al proposed a pressure sensor-based 

swift response anticollision system for an automatic railway gate control system [3].  

 

The pressure switches which have been integrated into this system detect the condition of 

whether any vehicle gets stuck at the level crossing or not. IR sensors have been used to 

detect the arrival and departure of the train. 

 

The system is a little bit complex and due to the use of IR sensors performance is not 

satisfactory. Sandya Goutam et.al concentrated on predicting the major cause of railway 

accidents which is a collision on the same track [4]. For this purpose, a technology used to 

identify train positions, collision detection, as well as the points where collisions may occur, 

has been used. The primary goal of this paper is the anti-collision system to identify such 



 

16 

collision points and to report the error cases to the main control room, nearby stations as 

well as grid control stations.  

 

To build this system, advanced sensing technology, a long-distance communication system 

(RS 485protocol), a microcontroller (8051), and a wireless communication protocol has 

been used. But this system is not concerned with the collision between the train and vehicles 

on the road. 

 

J. Banuchandar et.al proposed an automated unmanned railway level crossing system [5]. 

In this system when the train arrives in a particular direction the transmitter IR senses and 

generates the appropriate signal, then at the same time the receiver IR receives the signal 

and generates an interrupt. The main problem of this model is low accuracy because the 

interrupt signal can be generated even if a small object crosses the IR Sensor. Krishna et.al 

proposed a model to control railway tracks by using anti-collision techniques [6].  

 

The model of the railway track controller is designed by using 8952 microcontrollers to 

avoid railway accidents. When we go through the daily newspapers, we come across many 

railway accidents occurring at unmanned railway crossings. This model is implemented 

using the sensor technique. They placed the sensors at a certain distance from the gate to 

detect the approaching train and accordingly control the operation of the gate. 

 

Also, an indicator light has been provided to alert motorists about the approaching train. In 

their system, they have used an anti-collision device that uses GPS for preventing collision 

between two trains and an IR sensor for gate controlling at the level crossing. Sheikh 

Shanawaz Mostafa et.al proposed “A Radio-Based Intelligent Railway Grade Crossing 

System to Avoid Collision” [7].  

 

Their system offers an intelligent railway crossing control system for multiple tracks that 

features a controller which receives messages from incoming and outgoing trains by sensors. 

These messages contain detailed information including the direction and identity of a train. 

Depending on those messages the controller device decides whether the railroad crossing 

gate will close or open. This system is also complex and costly. Upon realizing the 
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importance of automatic railway gate controllers in India Acy M. Kottalil el. al proposed 

Automatic Railway Gate Control System gate[8].  

 

The objective of their system is to provide an automatic railway gate at a level crossing 

replacing the gates operated by the gatekeeper. The system reduces the time for which the 

gate remains closed. The system works on a microcontroller-based control. Their proposed 

system uses AT mega 16A microcontroller. With the help of IR sensors, the arrival and 

leaving of the system are monitored and the gate is operated accordingly.  

 

Anti-Collision and Secured Level Crossing Systems were proposed by K. Vidyasagar et. 

al[9]. Their proposed model presents an automatic rail gate control system at level crossing 

positions and an accident prevention mechanism. Two vibration sensors are used to control 

the open and closed state of the gate at the level crossing position. An ultrasonic sensor is 

positioned to detect an unauthorized object on the track.  

 

The open and closing status of the gate and unauthorized objects on the track will be 

communicated with the central control room using a wireless communication protocol. This 

system is complex, costly, and requires a lot of equipment to implement. The complex 

design, low performance, and cost have raised a question about the effectiveness of the 

approaches. 

 

2.3 Proposed Railway Gate Controlling System 

 

The proposed system uses ultrasonic sensors which have very high efficiency. These 

ultrasonic sensors are placed near the rail line at both sides of the level crossing. These 

sensors which are placed at a certain distance from the level crossing detect the train coming 

from either direction to the level crossing. Then the information about the train is transferred 

to the control unit and the control unit switches on the red light to generate an alarm and pull 

down the gate immediately.  

 

The sensors on either side determine whether the train passes a certain distance or not from 

the level crossing. If passes the controller switches on the green light stops the generation 

of the alarm and pulls the gate up. If any vehicle gets stuck at the level crossing of the rail 

line is detected by the sensor placed at the level crossing. Our proposed system is very simple 
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and inexpensive with respect to other systems but its performance is very laudable and 

excellent. 

 

2.4 Summary 

 

We try to do this project by reading the above literature, and we have been able to make 

our project successful by reducing the mistakes of last year's project. And it will be more 

efficient this year. In future we will add some more features, we will make it fully 

automatic. 
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CHAPTER 3 

HARDWARE AND SOFTWARE ANALYSIS 

 

3.1 Introduction  

This Project has worked on two things, Hardware and Software. Here we will discuss about 

our project hardware and software details.   

Hardware    

⮚ Arduino Nano 

⮚ Servo Motor  

⮚ Buck Converter 

⮚ GSM Module 

⮚ IR Sensor 

⮚ Relay 

⮚ SMPS 

⮚ Buzzer 

 

3.2 Arduino Nano 

Arduino is open-source electronics prototyping platform based on flexible, easy-to-use 

hardware and software. It's intended for artists, designers, hobbyists, and anyone interested 

in creating interactive objects or environments. Arduino can sense the environment by 

receiving input from a variety of sensors and can affect its surroundings by controlling 

Lights, motors, and other actuators. 

 

Figure 3.1: Arduino Nano  
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The microcontroller on the board is programmed using the Arduino programming language 

(based on Wiring) and the Arduino development environment (based on Processing). 

Arduino projects can be stand-alone or they can communicate with software running on a 

computer (e.g. Flash, Processing, Maxims’). 

Arduino Nano is a surface mount breadboard embedded version with an integrated USB. It 

is a small, complete, and breadboard-friendly component. It has everything that Decimal/ 

Duemilanove has (electrically) with more analog input pins and an onboard +5V AREF 

jumper. Physically, it is missing a power jack. The Nano can automatically sense and switch 

to the higher potential source of power.  

 

Figure 3.2: Arduino Nano Schematic Diagram 

Nano’s got the breadboard-ability of the Boarding and the Minibus with a smaller footprint 

than either, so users have more breadboard space. It’s got a pin layout that works well with 

the Mini or the Basic Stamp (TX, RX, ATN, and GND on one top, power, and ground on 

the other). This new version 3.0 comes with ATMEGA328 which offers more programming 

and data memory space. It has two layers. That makes it easier to hack and more affordable. 

One of the best features of Arduino Nano is, it’s easy to use, compact, and also small. 
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Specifications:  

● Microcontroller: Atmel ATmega328  

● Operating Voltage (logic level): 5 V  

● Input Voltage (recommended): 7-12 V  

● Input Voltage (limits): 6-20 V  

● Digital I/O Pins: 14 (of which 6 provide PWM output)  

● Analog Input Pins: 8  

● DC Current per I/O Pin: 40 mA  

● Flash Memory: 32 KB (of which 2KB used by the boot loader)  

● SRAM: 2 KB  

● EEPROM: 1 KB  

● Clock Speed: 16 MHz  

  

 

 

 

 

Figure 3.3: How Arduino Nano looks like 

Features:  

● Automatic reset during program download  

● Power OK blue LED  

● Green (TX), red (RX), and orange (L) LED  

● Auto sensing/switching power input  

● Small mini-B USB for programming and serial monitor  

● ICSP header for direct program download  

● Standard 0.1 spacing DIP (breadboard friendly)  

● Manual reset switch  
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The high-performance Microchip Pico Power 8-bit AVR RISC-based microcontroller 

combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM, 

2KB SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three 

flexible timer/counters with compare modes, internal and external interrupts, serial 

programmable USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-channel 

10-bit A/D converter (8-channels in TQFP and QFN/MLF packages), programmable 

watchdog timer with internal oscillator, and five software selectable power saving modes. 

The device operates between 1.8-5.5 volts. By executing powerful instructions in a single 

clock cycle, the device achieves throughputs approaching 1 MIPS per MHz, balancing 

power consumption and processing speed.  

Micro-controller IC ATmega328p 

 

Figure 3.4: Micro-controller IC AT mega 328p 

3.3 Switch Mode Power Supply (SMPS) 

A switched-mode power supply (switching-mode power supply, switch-mode power 

supply, switched power supply, SMPS, or switcher) is an electronic power supply that 

incorporates a switching regulator to convert electrical power efficiently. Like other power 

supplies, an SMPS transfers power from a DC or AC source (often mains power) to DC 

loads, such as a personal computer, while converting voltage and current characteristics.  

Unlike a linear power supply, the pass transistor of a switching-mode supply continually 

switches between low-dissipation, full-on and full-off states, and spends very little time in 

the high-dissipation transitions, which minimizes wasted energy. A hypothetical ideal 

switched-mode power supply dissipates no power. Voltage regulation is achieved by 

varying the ratio of on-to-off time (also known as duty cycles). In contrast, a linear power 

https://en.wikipedia.org/wiki/Power_supply
https://en.wikipedia.org/wiki/Voltage_regulator#Switching_regulators
https://en.wikipedia.org/wiki/Electrical_power_conversion
https://en.wikipedia.org/wiki/Mains_electricity
https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Voltage
https://en.wikipedia.org/wiki/Electric_current
https://en.wikipedia.org/wiki/Linear_power_supply
https://en.wikipedia.org/wiki/Dissipation
https://en.wikipedia.org/wiki/Voltage_regulator
https://en.wikipedia.org/wiki/Duty_cycle
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supply regulates the output voltage by continually dissipating power in the pass transistor. 

This higher power conversion efficiency is an important advantage of a switched-mode 

power supply. Switched-mode power supplies may also be substantially smaller and lighter 

than a linear supply due to the smaller transformer size and weight. 

 

 

 

Figure 3.5: SMPS 

Switching regulators are used as replacements for linear regulators when higher efficiency, 

smaller size, or lighter weight are required. They are, however, more complicated; their 

switching currents can cause electrical noise problems if not carefully suppressed, and 

simple designs may have a poor power factor.12V 5A Industrial SMPS Power Supply – 

60W – DC Metal Power Supply – Good Quality – Non-Waterproof with Aluminum casing. 

● Input Voltage: AC 100 – 264V 50 / 60Hz 

● Output Voltage: 12V DC, 0-5A 

● Output voltage: Adjustment Range: ±20% 

● Protections: Overload / Over Voltage / Short Circuit 

● Auto-Recovery After Protection 

● Universal AC input / Full range 

● 100% Full Load Burn-in Test 

● Cooling by Free Air Convection 

● High Quality and High Performance 

● LED power supply with a metal body for hidden installation for LED lighting 

● Design with Built-in EMI Filter, improve signal precision. 

● Certifications: CE & RoHS 

https://en.wikipedia.org/wiki/Transistor
https://en.wikipedia.org/wiki/Power_factor
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Switched-mode power supplies are classified according to the type of input and output 

voltages. The four major categories are: 

● AC to DC 

● DC to DC 

● DC to AC 

● AC to AC 

 

A basic isolated AC to DC switched-mode power supply consists of 

● Input rectifier and filter 

● Inverter consisting of switching devices such as MOSFETs 

● Transformer 

● Output rectifier and filter 

● Feedback and control circuit 

 

The input DC supply from a rectifier or battery is fed to the inverter where it is turned on 

and off at high frequencies of between 20 kHz and 200 kHz by the switching MOSFET or 

power transistors. The high-frequency voltage pulses from the inverter are fed to the 

transformer's primary winding, and the secondary AC output is rectified and smoothed to 

produce the required DC voltages. A feedback circuit monitors the output voltage and 

instructs the control circuit to adjust the duty cycle to maintain the output at the desired 

level.  

 

The basic working concept of an SMPS 

 

A switching regulator does the regulation in the SMPS. A series switching element turns the 

current supply to a smoothing capacitor on and off. The voltage on the capacitor controls 

the time the series element is turned. The continuous switching of the capacitor maintains 

the voltage at the required level. 
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Design basics 

 

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave 

bridge rectifier. The rectified voltage is next applied to the power factor correction (PFC) 

pre-regulator followed by the downstream DC-DC converter(s). Most computers and small 

appliances use the International Electrotechnical Commission (IEC) style input connector. 

As for output connectors and pinouts, except for some industries, such as PC and compact 

PCI, in general, they are not standardized and are left up to the manufacturer. 

 

Figure 3.6: SMPS Circuit Design  

 

There are different circuit configurations known as topologies, each having unique 

characteristics, advantages, and modes of operation, which determine how the input power 

is transferred to the output. Most of the commonly used topologies such as fly back, push-

pull, half-bridge, and full bridge, consisting of a transformer to provide isolation, voltage 

scaling, and multiple output voltages. The non-isolated configurations do not have a 

transformer and the power conversion is provided by the inductive energy transfer. 

 

 

 

 

 

 

https://www.electronicsforu.com/electronics-projects/power-factor-correction
https://www.iec.ch/about/?ref=menu
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Advantages of switched-mode power supplies: 

● Higher efficiency of 68% to 90% 

● Regulated and reliable outputs regardless of variations in input supply voltage 

● Small size and lighter 

● Flexible technology 

● High power density 

Disadvantages: 

● Generate electromagnetic interference 

● Complex circuit design 

● Expensive compared to linear supplies 

 

Switched-mode power supplies are used to power a wide variety of equipment such as 

computers, sensitive electronics, battery-operated devices and other equipment requiring 

high-efficiency 

Switch Mode Power Supply 

 

Figure 3.7: Power Supply Connection  

 

Linear voltage IC regulators have been the basis of power supply designs for many years as 

they are very good at supplying a continuous fixed voltage output. Linear voltage regulators 

are generally much more efficient and easier to use than equivalent voltage regulator circuits 
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made from discrete components such as a Zener diode and a resistor, or transistors and even 

op-amps.  

The most popular linear and fixed output voltage regulator types are by far the positive 

output voltage series and the 79 negative output voltage series. These two types of 

complementary voltage regulators produce a precise and stable voltage output ranging from 

about 5 volts up to about 24 volts for use in many electronic circuits. 

 

There is a wide range of these three-terminal fixed voltage regulators available each with its 

own built-in voltage regulation and current limiting circuits. This allows us to create a whole 

host of different power supply rails and outputs, either single or dual supply, suitable for 

most electronic circuits and applications. There are even variable voltage linear regulators 

available as well providing an output voltage that is continuously variable from just above 

zero to a few volts below its maximum voltage output. 

 

Most D.C. power supplies comprise a large and heavy step-down mains transformer, diode 

rectification, either full-wave or half-wave, a filter circuit to remove any ripple content from 

the rectified D.C. producing a suitably smooth D.C. voltage, and some form of voltage 

regulator or stabilizer circuit, either linear or switching to ensure the correct regulation of 

the power supplies output voltage under varying load conditions. Then a typical D.C. power 

supply would look something like this: 

Typical DC Power Supply 

 

Figure 3.8: DC Power Supply Step 

 

These typical power supply designs contain a large mains transformer (which also provides 

isolation between the input and output) and a dissipative series regulator circuit. The 

regulator circuit could consist of a single Zener diode or a three-terminal linear series 

regulator to produce the required output voltage. The advantage of a linear regulator is that 
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the power supply circuit only needs an input capacitor, an output capacitor, and some 

feedback resistors to set the output voltage. The voltage supply is the main factor in it. 

 

3.4 GSM Module 

At the heart of the module is a SIM800L GSM cellular chip from Sim Com. The operating 

voltage of the chip is from 3.4V to 4.4V, which makes it an ideal candidate for direct LiPo 

battery supply. This makes it a good choice for embedding into projects without a lot 

of space. 

 

 

Figure 3.9: GSM Module 

 

All the necessary data pins of the SIM800L GSM chip are broken out to a 0.1″ pitch header. 

This includes pins required for communication with a microcontroller over UART. The 

module supports the baud rates from 1200bps to 115200bps with Auto-Baud detection. 

 

 

Figure 3.10: GSM Module Introducing  
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The module needs an external antenna to connect to a network. The module usually comes 

with a Helical Antenna and solders directly to the NET pin on PCB. The board also has a 

U.FL connector facility in case you want to keep the antenna away from the board. 

 

There’s a SIM socket on the back! Any activated, 2G micro-SIM card would work 

perfectly. The correct direction for inserting a SIM card is normally engraved on the surface 

of the SIM socket. This module measures only 1 inch² but packs a surprising amount of 

features into its little frame. Some of them are listed below: 

 

● Supports Quad-band: GSM850, EGSM900, DCS1800, and PCS1900 

● Connect onto any global GSM network with any 2G SIM 

● Make and receive voice calls using an external 8Ω speaker & electret microphone 

● Send and receive SMS messages 

● Send and receive GPRS data (TCP/IP, HTTP, etc.) 

● Scan and receive FM radio broadcasts 

● Transmit Power: 

● Class 4 (2W) for GSM850 

● Class 1 (1W) for DCS1800 

● Serial-based AT Command Set 

● FL connectors for cell antennae 

● Accepts Micro SIM Card 

SIM800L GSM Module Pinout 

The SIM800L module has total 12 pins that interface it to the outside world. The connections 

are as follows: 

 

Figure 3.11: GSM Module Pinout 
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NET is a pin where you can solder Helical Antenna provided along with the module. 

VCC supplies power for the module. This can be anywhere from 3.4V to 4.4 volts. 

Remember connecting it to a 5V pin will likely destroy your module! It doesn’t even run on 

3.3 V! An external power source like a Li-Po battery or DC-DC buck converters rated 3.7V 

2A would work. 

 

● RST (Reset) is a hard reset pin. If you absolutely got the module in a bad space, 

pull this pin low for 100ms to perform a hard reset. 

● RxD (Receiver) pin is used for serial communication. 

● TxD (Transmitter) pin is used for serial communication. 

● GND is the Ground Pin and needs to be connected to the GND pin on the Arduino. 

● RING pin acts as a Ring Indicator. It is basically the ‘interrupt’ out pin from the 

module. It is by default high and will pulse low for 120ms when a call is received. 

It can also be configured to pulse when an SMS is received. 

● DTR pin activates/deactivates sleep mode. Pulling it HIGH will put the module in 

sleep mode, disabling serial communication. Pulling it LOW will wake the module 

up. 

● MIC± is a differential microphone input. The two microphone pins can be 

connected directly to these pins. 

● SPK± is a differential speaker interface. The two pins of a speaker can be tied 

directly to these two pins. 

 

3.5 Relay 

A relay is an electrically operated switch. Many relays use an electromagnet to 

mechanically operate a switch, but other operating principles are also used, such as solid-

state relays. Relays are used where it is necessary to control a circuit by a separate low-

power signal, or where several circuits must be controlled by one signal.  

The first relays were used in long-distance telegraph circuits as amplifiers: they repeated the 

signal coming in from one circuit and re-transmitted it on another circuit. Relays were used 

extensively in telephone exchanges and early computers to perform logical operations. 

https://en.wikipedia.org/wiki/Electric
https://en.wikipedia.org/wiki/Switch
https://en.wikipedia.org/wiki/Electromagnet
https://en.wikipedia.org/wiki/Solid-state_relay
https://en.wikipedia.org/wiki/Solid-state_relay
https://en.wikipedia.org/wiki/Electrical_telegraph
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A type of relay that can handle the high power required to directly control an electric motor 

or other loads is called a contactor. Solid-state relays control power circuits with no moving 

parts, instead using a semiconductor device to perform switching.  

Relays with calibrated operating characteristics and sometimes multiple operating coils are 

used to protect electrical circuits from overload or faults; in modern electric power systems 

these functions are performed by digital instruments still called "protective relays". 

Magnetic latching relays require one pulse of coil power to move their contacts in one 

direction, and another, redirected pulse to move them back. Repeated pulses from the same 

input have no effect. Magnetic latching relays are useful in applications where interrupted 

power should not be able to transition the contacts.  

 

 

Figure 3.12: Relay  

 

Magnetic latching relays can have either single or dual coils. On a single coil device, the 

relay will operate in one direction when power is applied with one polarity, and will reset 

when the polarity is reversed. On a dual coil device, when polarized voltage is applied to the 

reset coil the contacts will transition.  

 

 

 

 

 

 

https://en.wikipedia.org/wiki/Contactor
https://en.wikipedia.org/wiki/Solid-state_relay
https://en.wikipedia.org/wiki/Moving_parts
https://en.wikipedia.org/wiki/Moving_parts
https://en.wikipedia.org/wiki/Protective_relay
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AC-controlled magnetic latch relays have single coils that employ steering diodes to 

differentiate between operate and reset commands. 

 

 

Figure 3.13: Transistor Switching Circuit. 

 

The circuit above is called a low-side switch because the switch – our transistor – is on the 

low (ground) side of the circuit. Alternatively, we can use a PNP transistor to create a high-

side switch: Similar to the NPN circuit, the base is our input, and the emitter is tied to a 

constant voltage.  

 

A relay is an electrically operated switch of the mains voltage. It means that it can be turned 

on or off, letting the current go through or not. Controlling a relay with the Arduino is as 

simple as controlling an output such as an LED. The relay module is the one in the figure 

below.  
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This module has two channels (those blue cubes). There are other varieties with one, four, 

and eight channels. 

 

 

Figure 3.14: Relay Module. 

 

Mains voltage connections: 

In relation to mains voltage, relays have 3 possible connections: 

 

Figure 3.15: Pin diagram of Relay Module 

COM: common pin 

NO (Normally Open): there is no contact between the common pin and the normally open 

pin. So, when you trigger the relay, it connects to the COM pin, and supply is provided to a 

load 

NC (Normally Closed): there is contact between the common pin and the normally closed 

pin. There is always a connection between the COM and NC pins, even when the relay is 
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turned off. When you trigger the relay, the circuit is opened and there is no supply provided 

to a load. 

Pin wiring: 

The connections between the relay module and the Arduino are really simple: 

 

Figure 3.16: Main Voltage Connection 

● GND: goes to ground 

● IN1: controls the first relay (it will be connected to an Arduino digital pin) 

● IN2: controls the second relay (it should be connected to an Arduino digital pin if 

you are using this second relay. Otherwise, you don’t need to connect it)  

● VCC: goes to 5V 

 

3.6 IR Sensor:  

 

An infrared sensor is an electronic device that emits certain features around it and/or detects 

infrared radiation. Infrared sensors are capable of measuring the heat emitted by an object 

and detecting motion. In this project, we will control the fan and light automatically through 

the closed-loop system so the IR sensor for the system is definitely needed as a response.  
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Here the fan will turn on and the light will turn on when the IR sensor detects an object and 

the fan and light will switch off automatically when an object leaves the house. 

 

 

 

Figure 3.17:  IR Sensor 

 

 

 

 

Figure 3.18:  IR sensor reflection System. 

 

Principles of operation: 

 

Sensor works with sense. When an object intersects the sensor light then the sensor detects 

something. Some infrared ray is deflected from the object and scene the length of this 

distance. In this sensor, we can make a fixed-length light and detect our exact object.  
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If some object comes in front of this sensor, then the sensor detects it and sends a signal in 

LED. 

 

 

Figure 3.19:  IR sensor Detection System. 

 

 

3.7 5V Regulator IC 

Voltage sources in a circuit may have fluctuations resulting in not providing fixed voltage 

outputs. A voltage regulator IC maintains the output voltage at a constant value. 7805 IC, a 

member of the 78xx series of fixed linear voltage regulators used to maintain such 

fluctuations, is a popular voltage regulator integrated circuit (IC). The xx in 78xx indicates 

the output voltage it provides. 7805 IC provides +5 volts regulated power supply with 

provisions to add a heat sink.  
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7805 IC Rating  

● Input voltage range 7V- 35V  

● Current rating Ic = 1A  

● Output voltage range VMax=5.2V, VMin=4.8V 

 

Figure 3.20: 5V Regulator IC 

 

3.8  Buzzer 

Piezo elements are actually one of the coolest crystals you’ll play with. Flex them, they 

generate a voltage (pretty high, actually). Pass power through them, and they’ll flex. Do it 

fast enough, and they’ll start to make a sound! So besides making annoying little beeping 

noises, you could use it as a sensor to detect a knock or other similar vibration. 

 

 

 

 

 

Figure 3.21: Buzzer  
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Specifications 

• Operating Voltage:  1.0 ~ 20.0V 

• Rated Voltage:   3.0V 

• Diameter:  Ø12.5mm 

• Total Height:  6.3mm 

• Capacitance:  15,000pF 

 

3.9 The Smoothing Capacitor 

When there is a potential difference across the conductors (e.g., when a capacitor is attached 

across a battery), an electric field develops across the dielectric, causing positive charge 

(+Q) to collect on one plate and negative charge (-Q) to collect on the other plate. If a battery 

has been attached to a capacitor for a sufficient amount of time, no current can flow through 

the capacitor. However, if an accelerating or alternating voltage is applied across the leads 

of the capacitor, a displacement current can flow. 

 

Figure 3.22: Capacitor 

An ideal capacitor is characterized by a single constant value for its capacitance. 

Capacitance is expressed as the ratio of the electric charge (Q) on each conductor to the 

potential Difference (V). The SI unit of capacitance is the farad (F), which is equal to one 

coulomb per volt (1 C/V). Typical capacitance values range from about 1 pF (10−12 F) to 

about 1 mF (10−3 F). The capacitance is greater when there is a narrower separation between 

conductors and when the conductors have a larger surface area. 
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In practice, the dielectric between the plates passes a small amount of leakage current and 

also has an electric field strength limit, known as the breakdown voltage. The conductors 

and leads introduce an undesired inductance and resistance.  

Capacitors are widely used in electronic circuits for blocking direct currents while allowing 

alternating currents to pass. In analog filter networks, they smooth the output of power 

supplies. In resonant circuits, they tune radios to particular frequencies. In electric power 

transmission systems, they stabilize voltage and power flow. 

 

Figure 3.23: The Smoothing Capacitor with Full Bridge Rectifier 

The full-wave bridge rectifier however, gives us a greater mean DC value (0.637 Vmax) 

with less superimposed ripple while the output waveform is twice that of the frequency of 

the input supply frequency. We can improve the average DC output of the rectifier while at 

the same time reducing the AC variation of the rectified output by using smoothing 

capacitors to filter the output waveform.  

Smoothing or reservoir capacitors connected in parallel with the load across the output of 

the full wave bridge rectifier circuit increase the average DC output level even higher as the 

capacitor acts like a storage device as shown below.  

Too low a capacitance value and the capacitor have little effect on the output waveform. But 

if the smoothing capacitor is sufficiently large enough (parallel capacitors can be used) and 

the load current is not too large, the output voltage will be almost as smooth as pure DC.  
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3.10 Resistor 

 

A resistor is a passive two-terminal electrical component that implements electrical 

resistance as a circuit element. Resistors act to reduce current flow, and, at some time, act 

to lower voltage levels within circuits. Resistors may have fixed resistances or variable 

resistances, such as those founding thermostats, visitors, trimmers, photo resistors, 

hamsters, and potentiometers. The current through a resistor is in direct proportion to the 

voltage across the resistor's terminals. This relationship is represented by Ohm's law. 

 

 

Figure 3.24: Resistor 

 

 

 

Theory of operation: 

 

The behavior of an ideal resistor is dictated by the relationship specified by Ohm ‘slaw: 

V = I.R 

 

Ohm's law states that the voltage (V) across a resistor is proportional to the current (I), where 

the constant of proportionality is the resistance (R). 

 

Equivalently, Ohm's law can be stated: 

I = V/R 

 

This formulation states that the current (I) is proportional to the voltage (V) and inversely 

proportional to the resistance (R). This is directly used in practical computations. For 

example, if a 300-ohm resistor is attached across the terminals of a12 volt battery, then a 

current of 12 / 300 = 0.04 amperes flows through that resistor. 
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3.11 Arduino Software  

The digital microcontroller unit named Arduino Nano can be programmed with the Arduino 

software IDE. There is no requirement for installing other software rather than Arduino. 

Firstly, Select "Arduino Nano from the Tools, Board menu (according to the microcontroller 

on our board). The IC used named ATmega328 on the Arduino Nano comes pre-burned with 

a boot loader that allows us to upload new code to it without the use of an external hardware 

programmer. 

Communication is using the original STK500 protocol (reference, C header files). We can 

also bypass the boot loader and programs the microcontroller through the ICSP (In-Circuit 

Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards) 

firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU boot loader, 

which can be activated by: 

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of 

Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulls the 

8U2/16U2 HWB line to the ground, making it easier to put into DFU mode. 

The Arduino Nano is one of the latest digital microcontroller units and has a number of 

facilities for communicating with a computer, another Arduino, or other microcontrollers. 

The ATmega328 provides UART TTL at (5V) with serial communication, which is 

available on digital pins 0 -(RX) for receiving the data and pin no.1 (TX) for transmitting 

the data.  

An ATmega16U2 on the board channels this serial communication over USB and appears 

as a virtual com port to software on the computer. The '16U2 firmware uses the standard 

USB COM drivers, and no external driver is needed. However, on Windows, a .in file is 

required. The Arduino software includes a serial monitor which allows simple textual data 

to be sent to and from the Arduino board. 

The RX and TX LEDs on the board will flash when data is being transmitted via the USB-

to-serial chip and USB connection to the computer (but not for serial communication on 

pins 0 and 1). A Software Serial library allows for serial communication on any of Nano's 

digital pins. The ATmega328 also supports I2C (TWI) and SPI communication. The 

Arduino software includes a Wire library to simplify the use of the I2C bus. Arduino 
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programs are written in C or C++ and the program code written for Arduino is called a 

sketch. The Arduino IDE uses the GNU toolchain and AVR Lab to compile programs, and 

for uploading the programs it uses argued. As the Arduino platform uses Atmel 

microcontrollers, Atmel's development environment, AVR Studio, or the newer Atmel 

Studio, may also be used to develop software for the Arduino. 

 

Figure 3.25: Arduino Software Interface IDE 

Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are 

written in the text editor and are saved with the file extension. ino. The editor has features 

for cutting/pasting and searching/replacing text. The message area gives feedback while 

saving and exporting and also displays errors. The console displays text output by the 

Arduino Software (IDE), including complete error messages and other information. The 

bottom righthand corner of the window displays the configured board and serial port. The 

toolbar buttons allow you to verify and upload programs, create, open, and save sketches, 

and open the serial monitor. 

Burn Bootloader 

The items in this menu allow you to burn a bootloader onto the microcontroller on an 

Arduino board. This is not required for the normal use of an Arduino or Genuino board but 
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is useful if you purchase a new ATmega microcontroller (which normally comes without a 

boot loader). Ensure that you've selected the correct board from the Boards menu before 

burning the bootloader on the target board. This command also set the right fuses. 

Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board 

and Tools > Port menus. The boards are described below. On the Mac, the serial port is 

probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or 

/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial 

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board) - to find out, you look for a USB serial device in the 

ports section of the Windows Device Manager.  

On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx, or similar. Once you've selected the 

correct serial port and board, press the upload button in the toolbar or select the Upload item 

from the Sketch menu. Current Arduino boards will reset automatically and begin the 

upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the reset 

button on the board just before starting the upload. On most boards, you'll see the RX and 

TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) will display a 

message when the upload is complete, or show an error. 

Libraries 

Libraries provide extra functionality for use in sketches, e.g. working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library 

menu. This will insert one or more #include statements at the top of the sketch and compile 

the library with your sketch. Because libraries are uploaded to the board with your sketch, 

they increase the amount of space it takes up. If a sketch no longer needs a library, simply 

delete its #include statements from the top of your code. 

Serial Monitor 

This displays serial sent from the Arduino or Genuino board over USB or serial connector. 

To send data to the board, enter text and click on the "send" button or press enter. Choose 
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the baud rate from the drop-down menu that matches the rate passed to Serial. begin in your 

sketch. Note that on Windows, Mac, or Linux the board will reset (it will rerun your sketch) 

when you connect with the serial monitor.  

Please note that the Serial Monitor does not process control characters; if your sketch needs 

complete management of the serial communication with control characters, you can use an 

external terminal program and connect it to the COM port assigned to your Arduino board. 

You can also talk to the board from Processing, Flash, MaxMSP, etc (see the interfacing 

page for details). 

 

3.12 Proteus Software 

 

 

Figure 3.26: Proteus Software Interface 

 

The Proteus Design Suite is a proprietary software tool suite used primarily for electronic 

design automation. The software is used mainly by electronics design engineers and 

technicians to create schematics and electronic prints for manufacturing printed circuit 

boards. The first version of what is now the Proteus Design Suite was called PC-B and was 

written by the company chairman, John Jameson, for DOS in 1988.  
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Schematic Capture support followed in 1990 with a port to the Windows environment 

shortly thereafter. Mixed mode SPICE Simulation was first integrated into Proteus in 1996 

and micro-controller simulation then arrived in Proteus in 1998.  

Shape-based auto routing was added in 2002 and 2006 saw another major product update 

with 3D Board Visualization. More recently, a dedicated IDE for simulation was added in 

2011 and MCAD import/export was included in 2015. Support for high-speed design was 

added in 2017. Feature-led product releases are typically biannual, while maintenance-

based service packs are released as required.  
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CHAPTER 4 

METHODOLOGY 

 

4.1 Block Diagram 

The block diagram here is representing the whole circuit and the components of the project. 

Here we have used standardized symbols and lines. 

 

Figure 4.1: Block Diagram of Our System 

4.2 Schematic Diagram  

The schematic diagram here is representing the electrical circuit and the components of the 

project. Here we have used standardized symbols and lines. 

 

Figure 4.2: Schematic Diagram of Project 
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4.3 Working Principle 

The way our Automatic Motion Sensing Barrier Gate Control System with Automated 

Sirens and Signal System works is that we take the 220V rms from the supply voltage and 

then give it to the SMPS, the SMPS has a step-down transformer inside that stepped that 

voltage down to 5V DC. We feed this voltage to the Arduino Nano Micro-controller for it 

to run.  

This project has two gates. When the train arrives at the gate, the IR sensor will sense the 

train and send a signal to Arduino Nano. That signal will command the servo motor to close 

the gate. then sirens will ring and send a text to the gateman's phone.  The gate will open 

automatically after the train leaves. When the train is close to the next IR sensor the train 

will automatically slow. This is the main procedure of our system. 

4.4 Our Final Project View 

Here we have shown the final project overview with appropriate marking. Like train, rail 

line, board etc. 

 

Figure 4.3: Our Final Project Overview 
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FIGURE 4.4: Our Final System Overview 
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CHAPTER 5 

RESULT AND DISCUSSION 

 

 
5.1 Discussion 

 

While working on our project, we did face some difficulties as it is a very complex system 

but the end results, we came up with were quite satisfactory. We have put the whole system 

through several tasks to validate our work and also have taken necessary notes for future 

improvements. Some future recommendations that we have involve improvement in 

system design and wiring, adding features for more efficiency.  

 
5.2 Results included (Mobile Signals) 

Now, it’s time to talk about the results. We have written our commands using the Arduino 

IDE and the following things can happen:  

● After powering this project then it will be able to operate. 

● Then the train will run on the line. 

● When the train crosses the IR sensor in front of the gate then the system sends a 

text to the gateman, automatically controlling the gate and buzzer ring. 

● When the train comes in front of another IR sensor then the train will be slow. 

 

 

Figure 5.1: GSM sends an alert to gateman's mobile when the train is in front of gate  
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5.3 Advantages 

 

There are many advantages of our project because of its accuracy. Some of the advantages 

are pointed out below: 

 

● Minimize railway accidents. 

● Automatic text sends to gateman's phone. 

● Less power consumption with the best utilization. 

● The system is user-friendly. 

 

 

 

5.4 Applications 

 

This project has applications in many fields due to its necessity. We have selected a few of 

them and they are given below: 

• Automatic Railway Gate Control purpose 

• Automatic Railway Gate Sirens purpose 

• Automatic SMS To the Railway Gateman's Phone purpose 

• Automatic Signal If Any Object Detected on The Railway purpose 
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CHAPTER 6 

CONCLUSION 

 

 

6.1 Conclusion 

 

To save human life and vehicles from miserable train accidents is a challenge of the era of 

modern science and technology. The working model was fabricated within the laboratory 

premises. The results exhibit that it is one of the expedient approaches for a secure railway 

system. The IR sensors detect the train stuck on the level crossing very quickly and 

communicate with the control unit and send the text to the gateman's phone. Another IR 

sensor detects the train and slows the train. The control unit takes proper steps which lead 

the train and vehicle's movements either to move forward or to stop to avoid the collision. 

Consequently, this is able to play a great contribution to railway gate automation with 

reliability and lower cost. 

 

6.2 Future Scope 

 

● In the future, we make it more efficient. 

● In the future, we are thinking about adding more features to the system such as sensors 

and monitoring cameras. 
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